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A Minitab Guide to Statistics was written to introduce professionals and students to Minitab, a general
purpose statistical computer system. This guide gives comprehensive information on the use of
Minitab in statistics. Included are statistical concepts and techniques that are generally covered in a
basic statistics course.

More About Minitab

Minitab was developed at Penn State in 1972 for students in introductory statistics courses. Since then,
Minitab has evolved into a comprehensive statistical system that is also used by students in advanced
data ahalysis courses, and by scientists, engineers, and managers in business, government, and
industry. Minitab is the international standard for the teaching of statistics. It is used at more than
5,000 sites in 60 countries.

Minitab runs on PCs, Macintosh computers, workstations, minicomputers, and mainframes. Although
there are some differences in Minitab across releases and computer platforms, the commands and
worksheet are basically the same.

This guide was developed for use with Minitab Release 13 as well as prior releases. All dialog boxes,
graphs, and other output are produced with Release 13. If you have a different Minitab release, most
of the commands are compatible, but the output may differ. We also worked all examples with Minitab
Student Release 12. Menu and session commands and output are quite similar to Release 13, but some
simulations in Chapter 6 will have to be reduced in size because of available memory.

Features

This guide illustrates the use of Minitab in organizing and analyzing data. As statistical concepts are
introduced in each chapter, we present appropriate Minitab commands, and provide step-by-step
descriptions of how to effectively use Minitab. Interesting real world data sets are used throughout the
guide in examples, and exercises which conclude each chapter. A computer diskette containing many
of the data sets is available. The Appendix describes the large data sets. We have chosen examples
and exercises from myriad professions, including business, education, government, health, medicine,
and sports.

The chapters in this guide are designed to correspond to chapters of leading statistics texts. The final
chapter of the supplement describes a survey sampling project. The objectives of the project are to
illustrate the use of Minitab in questionnaire evaluation and to provide a review of statistical
techniques.



Preface

How to Use this Guide

The only way to learn Minitab is by doing Minitab. Since this software is relatively easy to use, you
will experience success very quickly as you produce professional graphs within a short time. We
encourage you to redo the examples that we have included in this guide. Most of the data sets are on
a disk; the menu path and session commands are provided for each example. After you have mastered
our examples, try the exercises at the end of the chapters.

Minitab works with data in a worksheet of columns and rows, very much like a spreadsheet. The
commands are available through menus or through a command language in the Session window. If
you are using Windows, you probably will use menu commands more often; however, menu and
session commands can be used interchangeably. We show menu paths and session commands side-by-
side for each example.

Clicking on a menu usually opens a dialog box allowing you to select variables and choose options.
You will find dialog boxes throughout the guide. To select variables, you need to have the cursor in
the box in which you want to enter the variables. Then highlight the variable(s) in the list of variables
box and press Select or double-click on the variables. You can also type the column number or name
in the box. We indicate this step in the menu path with the word Select followed by the name of the
column.

As we name new columns or constants in a dialog box, we indicate this in the menu path with the word
Enter followed by a column name. Minitab automatically uses the next available column or constant.
Since the commands are printed in the session window, you can follow the action.

If you are using only session commands, you can follow the step-by-step list of commands to the right
of the menu paths. The success will depend on the version of Minitab that you are using. Check the
Help facility if you get an error message.

Where to find More Information about Minitab

There are additional texts available for information on Minitab. We recommend the Minitab User’s
Guides from Minitab, Inc. You can also access Minitab information 24 hours a day on the World Wide
Web at the address below. There you can download Minitab macros, find press releases, capabilities
lists, and product information, and view graphical samples. Information about Minitab software and
texts may be obtained from:

Minitab, Inc.
3081 Enterprise Drive
State College, PA 16801-3008

Telephone: 1-814-238-3280
Fax: 1-814-238-4383
Website: www.minitab.com
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CHAPTER 1

INTRODUCTION TO MINITAB

Minitab' is a computer software package that can increase your understanding of statistics and decrease
your calculation time. It was originally designed to be an easy-to-use statistical system to help in the
teaching of statistics. It has evolved into a powerful package for data analysis and graphics. In this
chapter we give a general view of how Minitab works, and illustrate some menu and session commands

to enter, print, and save data.

MINITAB COMMANDS INTRODUCED IN THIS CHAPTER

END INSERT NAME PRINT READ
SET STOP

1.1 ACCESSING MINITAB

Minitab is available on PC and Macintosh computers, minicomputers, or mainframes. Although there
are some differences in Minitab across releases and computer platforms, the commands and worksheet
are basically the same.

MICROCOMPUTER ENVIRONMENT

If you use a microcomputer, you need to be familiar with the operating system, the directory and path
names, disk drives, and diskettes. If you need more practice with these features, please refer to your
system's user guide.

With the Minitab user interface, you can type commands and subcommands in the session window or
you can execute them by choosing from menus and by completing dialog boxes. The commands and
corresponding output are given in the session window. In addition, you can copy, edit, and execute
previous commands.

To use a Windows version of Minitab, you need to know the basics of Windows. This includes moving
and resizing windows, using menus, and using dialog boxes. If you are not familiar with these basics,

! Minitab is a trademark name of Minitab, Inc.
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please refer to documentation or the online help facility on Windows.

To start Minitab using Windows, double click the shortcut to Minitab icon on the desktop or choose
the path:

Start » Programs » MINITAB 13 for Windows » MINITAB

The screen that you will see is similar to that shown below. It contains the session and data windows,
menu bar, standard and project manager toolbars, and status bar. These windows can be repositioned
or resized.

Menu Bar Standard Toolbar Project Manager Toolbar

Title

— 1726/01 11:2831 AM

o
Session Welcome to Minitab, press F1 for help.
NTB >

Window

Data
Window

Status Bar

The session window lets you create a program by typing commands and subcommands. Typically
menu and session commands, subcommands, and the corresponding output are displayed as they are
executed. Data entered in the session window are also displayed. The data window allows you to
enter data in a worksheet either by typing, generating, or importing data from a file.

Across the top is the menu bar, from which you can open menus and choose commands. Click on a
menu item, then click again to open a submenu, execute a command, or open a dialog box. Menu
items that are dimmed are not currently available for use.
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For example, if you choose the path
Window > Project Manager

the following screen is opened.

Y R i —

-{_1] Graphs
(2] ReportPad
Related Documents
8- Worksheets

B-E3 Worksheet 1
i Columns
(2] Constants

Minitab’s project manager is new in Release 13. It allows you to better organize and manage your
work. The following folders contain commands, data, output, graphs, and other related documents.

« Session Use this folder to copy, delete, or print output and graphs from the session window.
You can append contents of the session window to the ReportPad.

» History This folder contains all the commands used during a project session. Use this folder
to repeat a sequence of commands or to create a macro (described in Chapter 2).

» Graph Use this folder to manage all graphs. You can delete, arrange, or append graphs to
the ReportPad.

* ReportPad This is Minitab’s new word processor to create reports. Right-click output or
graphs to add to the ReportPad. You can edit and print a report from the ReportPad, or copy

to another word processor such as Microsoft Word.

* Related Documents This gives a list of other related non-Minitab files, documents, or
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Internet URLSs for reference or other use.

Worksheet Use this folder for information on worksheets including columns, constants,
counts of columns, missing values, and matrices.

The project manager toolbar provides shortcuts to these folders.

The standard toolbar displays buttons for commonly used functions; the buttons change depending
on which window is active. Place your mouse pointer over the button to see its name. Here is the
standard toolbar when the data window is active.

For example, the icons

The status bar at the bottom of the screen displays explanatory text for the menu item or toolbar button
you are currently using.

We use Release 13 for Windows to illustrate all examples in this guide. The session

[ :I window commands and corresponding output are provided in each example. If you
are using other releases of Minitab, most of the commands have the same

NOTE arguments and subcommands, some of the output may differ slightly. Refer to the

Minitab User’s Guide for your Release or the HELP facility for specific
information on commands that differ from the examples in this guide. We worked
all examples with Minitab Student Release 12 and added notes in the simulation
examples where you may have insufficient memory.

MAINFRAME VERSION
If you use a mainframe computer, you need to learn how to 'log on' to the system. Generally the log
on procedure requires you to enter an account number, a user name or user identification, and a

password.

If you are successful with the log on procedure, you are in the computer's operating system. The
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computer usually gives you information about the system, and then a system prompt. It expects you
to respond with a system command. The procedure for accessing Minitab varies, but generally, you
need to type the word Minitab following the system prompt. The system responds with the version
of Minitab that it has in its library, some information on Minitab, and the MTB > prompt. You can
then enter Minitab session commands.

1.2 MINITAB WORKSHEET

Minitab works with data in a worksheet of columns and rows. Usually, a column contains the data for
one variable, with an observation in each row or a data point in each cell. Columns are denoted C1,
C2,C3, ..., and rows within columns are numbered 1, 2, 3, and so on. Most Minitab work is done
in columns. The first row is reserved for column names.

l Cl C2 C3 C4 5 Cé

Name

AW N | —

Multiple worksheets are available with Minitab Release 13 with each worksheet allowing up to 4,000
columns. The numbers of rows and cells depend on the memory allocation. You can control this if
you choose

Edit » Preferences » General
Move the slider in the memory usage section somewhere between the following endpoints:
* Share nicely. Minitab will share more memory with other programs currently running.
» Use as much as necessary. Minitab will use as much memory as necessary, sharing less

memory with other programs currently running.

Multiple worksheets are also available with Student Release 12 with each worksheet allowing up to
1,000 columns with 5,000 data points. The size is displayed on the screen when you start Minitab.
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WORKING WITH THE WORKSHEET

Columns
type of data can be assigned or changed.

column.

Rows

observations in C2.

Cells

This section gives more details on Minitab’s worksheet. Usually a column contains the
data for one variable, with an observation in each row or a data point in each cell.

* A column contains alpha or numeric data (date/time is a third type of data). The

*  Minitab identifies a column as alpha or numeric by the first value entered in that

* Individual rows can be accessed by specifying the row number in parentheses
following the column number or name; C1(9) denotes the ninth row of C1.

* The subscript can be any expression which produces a positive integer.
C1(COUNT(C2)) denotes the row of CIl corresponding to the number of

*  Cells in a data window contain values that you enter or generate with commands.
*  Cells do not contain formulas as in Microsoft Excel and Lotus 1-2-3.

MINITAB CONSTANTS

Minitab can store individual numbers, such as an average or standard deviation, in constant locations

denoted K1, K2, K3, ...

Constants are created by LET or by any command that produces a single

number answer. An example is MEAN, the command that calculates the arithmetic average. The
result of the command is automatically printed; you need to print the stored constant to view it. For
example, if a column named Scores contains test results, the MEAN command below calculates, prints,

and stores the mean in a constant K1. The PRINT command prints K1.

For more advanced work, Minitab has matrices denoted M1, M2, M3, ...

MTB > MEAN ‘Scores’ K1l
Mean of Scores

Mean of Scores = 76.600
MTB > PRINT K1
Data Display

K1l 76.600

Each matrix can store one
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table of numbers. The number of available matrices depends on your computer.

When you begin a Minitab session, the worksheet is blank. During the session, you enter data in the
worksheet, work with the data, and then you can save to a file for future use. Minitab reminds you to
save your work before you end a session.

1.3 MENU AND SESSION COMMANDS

Minitab commands are available through the menus or through a command language in the session
window. These commands, called menu commands and session commands, can be used

interchangeably.
USING MENU COMMANDS

To use menu commands, click on an item in the menu bar to open the menu, execute a command, open
a submenu, or open a dialog box. If a menu item is dimmed, it is currently unavailable.

‘For example, to open the data window, click the Window menu, then click Worksheet. This path is
shown in this guide as

Window » Worksheet

Choosing a command from a menu usually opens a dialog box allowing you to select variables and
choose options. To select variables, you need to have the cursor in the box in which you want to enter
the variables. Then highlight the variable(s) in the list of variables box and press Select. The
variable(s) will appear in the box with the cursor.

You can name new columns in a dialog box. For example, when you use the Calculator function, you
can name a column or constant in which to store the results. Minitab will automatically use the next
available column or constant.

The OK button in the dialog box is usually the last button to press to activate a

m command. Pressing the Enter Key is the same as the OK button. You want to be
sure the dialog box is completed before you press OK or the Enter key. For all the

NOTE exercises in this guide, we provide the steps and the variables to select, and use OK

after the final step is complete.
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USING SESSION COMMANDS

Session commands are useful alternatives to menu commands, especially when you want to use macros
to automatically repeat a series of commands. Most session commands are simple, easy to remember
words, like PLOT, SAVE, or SORT.

You can execute session commands in either the session window, or by using the command line editor.
To execute commands in the session window, type the commands at the MTB > prompt. If the MTB
> prompt is not displayed in the session window, choose

Editor » Enable Commands

The command line editor lets you edit a set of commands and data before you actually execute the
commands. To execute commands using the command line editor, choose

Edit » Command Line Editor
and type, paste, and edit commands in the command line editor window. Then click
Submit Commands

to execute the commands in the session window. For example, type the following lines in the
command line editor:

 Command Lin dilm

Sel
1123453456 34
‘{End

and click Submit Commands. The data will be entered in column C1.



Introduction to Minitab 9

MTB > Set Cl

DATA> End
NTB >

9/11/00 8:18:04 AM
Welcoms to Minitab, press Fl for help.

I DATA> 23 45 34 56 34

NOTE

Minitab has several hundred different commands, some of which have options and
subcommands. Whenever we introduce a command or subcommand, we give a
brief description, the Release 13 for Windows menu command in bold print, and the
session commands with arguments and subcommands. Refer to the HELP facility
for additional information concerning other Minitab versions.
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MORE ON SESSION COMMANDS

This section gives details on Minitab’s command structure. Commands have arguments
to identify columns and constants. Most commands have subcommands to specify options
or to provide additional output. Subcommands are very similar to menu command

options.

Commands
»  Type the command and arguments in proper order on the command line. No extra text
is allowed on the command line
» Each command must begin on a new line. If a command does not fit on one line, use
the ampersand symbol & or two plus ++ symbols at the end of the command line.
Minitab responds with CONT>, and you can continue the command.

Subcommands

e To use one or more subcommands, end the command line with a semicolon and a
SUBC> prompt will appear on the next line.

* Type the subcommands and arguments in proper order, ending each line with a
semicolon.

«  End the last subcommand line with a period. If you forget to place a period, you will
get the SUBC> prompt; enter a period on that line.

« If you make a mistake, enter ABORT on a new subcommand line. This cancels the
command and all subcommands.

Speclfymg Arguments

An argument entered on a command or subcommand line can be a column, constant,
text string, or a number.

«  Enter column numbers (C1) or column names ('Sales'), stored constants (K5) or names
('Mean'), or a computer file (‘'Problem2.mtp").

* Enclose text strings such as titles or file names in double quotes ("Population of the
Fifty States").

* Enclose a constant in double quotes if you want to use it as text ("1999").

* Abbreviate a set of consecutive columns or stored constants with a dash
(PRINT C1-C5 is the same as PRINT C1 C2 C3 C4 C5.

*  Abbreviate a sequence of numbers with a colon (1:5 is the same as 1 2 3 4 5).

1.4 ENTERING DATA FROM THE KEYBOARD

Minitab provides many ways to enter data in a worksheet. You can type data in the data or session
windows, open a file, paste data from the clipboard, or generate data. This section shows you how to
enter data from the keyboard in both the data and session windows and how to generate patterned data.
Minitab uses alpha or text data, numeric data, and date/time data. Although some commands such as
those for input, output, and editing work with alpha data, most Minitab commands work only with
numeric data. Alpha data, for example the names of companies, are often used as row labels.



